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About This Document

This user guide describes how to install and operate Multi-Site 4200 video management 
software on a PC workstation. These instructions are intended for system integrators, installers, 
and end-user operators.

Overview of Contents

This document contains the following chapters and appendixes:

• Chapter 1, Getting Started, describes installation and first-time setup procedures.

• Chapter 2, Basic Operations, describes procedures for viewing, recording, and playing 
back video.

• Chapter 3, Management, describes procedures for managing devices, logs, alarms, 
e-maps, and user accounts.

• Chapter 4, Configuration, describes procedures for remotely configuring DVRs and 
cameras, and for configuring Multi-Site 4200’s system settings.

• Appendix A, Troubleshooting, lists possible resolutions to common problems.
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Related Documents

For more information about using the HRGX DVR, refer to the following documents:

* These part numbers are subject to change. Please consult the HRGX Performance Series DVR 
product webpage for the latest versions:

http://www.honeywellvideo.com/products/video-systems/recording-devices/analog
/performance-series/757666.html

Document title Part number*

HRGX DVR Getting Started Guide 800-16693

HRGX DVR User Manual 800-16694

HRGX DVR Remote Web Access User Guide 800-18321

HRGX DVR Apple iPhone Mobile App User Guide 800-19166

HRGX DVR Apple iPad Mobile App User Guide 800-18322

HRGX DVR Android Mobile App User Guide 800-18323

Multi-Site 4200 User Guide for Mac 800-13101

http://www.honeywellvideo.com/products/video-systems/recording-devices/analog/performance-series/757666.html
http://www.honeywellvideo.com/products/video-systems/recording-devices/analog/performance-series/757666.html
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1
Getting Started 1

This chapter contains the following sections:

• About Multi-Site 4200 on page 9

• Installing Multi-Site 4200 on page 10

• Registering an Administrator Account on page 11

• Running the Setup Wizard on page 11

• Overview of User Interface Layout on page 16

About Multi-Site 4200

Multi-Site 4200 provides centralized management of Honeywell HRGX Performance Series 
DVRs and connected cameras over a network. 

Multi-Site 4200 is scalable and offers a variety of configuration modules for small or large video 
surveillance installations. The software comes with a comprehensive feature set that includes 
simultaneous live view and playback of cameras from multiple sites, real-time monitoring and 
recording, and file backup.
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Installing Multi-Site 4200

To run Multi-Site 4200, your workstation must meet the following minimum requirements:

Note Multi-Site 4200 is designed for 32-bit versions of Windows but will also run on 
64-bit operating systems.

To install Multi-Site 4200

1. Insert the CD that came with your DVR or download and extract the latest Multi-Site 4200 
installer package.

2. Double-click Multi-Site 4200.exe to launch the InstallShield Wizard.

3. Follow the wizard’s on-screen instructions.

Note You must have administrator privileges to install Multi-Site 4200.

To confirm the installation

Go to the Start menu. If the installation was successful, Multi-Site 4200 will appear in the list of 
installed programs.

Operating System Windows 8 (32/64-bit)
Windows 7 (32/64-bit)
Windows Server 2008 (32/64-bit)
Windows Server 2003 (32-bit)
Windows XP (32-bit)

CPU Pentium 4, 3.0 GHz or faster

System Memory 1 GB (32 bit)

Display Resolution 1024 × 768 or higher
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Registering an Administrator Account

The first time you start Multi-Site 4200, you will need to register an administrator ("super user") 
account.

To register an administrator account

1. On your desktop, double-click the 
Multi-Site 4200 icon. The Register 
Administrator dialog box opens.

2. In Super User, type your name.

3. In Password, type your password 
(minimum 6 characters).

4. In Confirm, re-type your password.

5. If you want to be logged in automatically 
from now on, select the Enable Auto login check box.

6. Click Register to save your settings.

Running the Setup Wizard

After you have registered an administrator account, a setup wizard opens. 

On the welcome page, click Enter Wizard to continue to the Add Device page.

Note You may be prompted for an administrator password during the setup process.
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Adding a Device

To add a device:

1. On the Add Device page, click Show Online Devices to see a list of DVRs on the same 
network (LAN) as your PC running Multi-Site 4200.

2. In the Show Online Devices dialog box, in the list of discovered devices, click the DVR 
that you want to add, and then click Select Device.

3. Click Yes to confirm that you want to add the selected device.

4. If your DVR uses hrgDDNS (a free Dynamic DNS service), in the Add Device dialog box, 
select the Private Domain Mode check box. If your DVR does not use hrgDDNS, leave the 
box unchecked.
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5. In Nickname, type a descriptive name for 
your DVR.

6. If Private Domain Mode is enabled, in DNS 
Address, type www.hrgdvr-ddns.com.

If Private Domain Mode is not enabled, the 
Address box should show your DVR’s IP 
address or its DynDNS address. If the box is 
blank, type the DVR’s IP address or its 
DynDNS address.

7. If Private Domain Mode is enabled, in 
Device ID, type the serial number of your 
DVR (you can find this in Menu > 
Maintenance > System Info > Device 
Info on the DVR).

If Private Domain Mode is not enabled, the 
Port box should show your DVR’s device 
port number (also known as the server port number). If the box is blank, type the device 
port number of the DVR. The default port number is 8000.

8. In User Name, type the user name of your DVR. (The default user name is admin.)

9. In Password, type the password of your DVR. (The default password is 12345.)

10. Click Add to add your DVR to the devices list, and then click Next to continue to the next 
page.

Adding a Group

Note If the Export to Group check box was selected when you added your DVR to the 
devices list, a group was created for your DVR and your DVR’s channels were added 
to it. If you do not want to make any more changes, click Cancel to close the wizard.

On the Add Group page, you can add, modify, or delete a group. You can add up to 256 
groups.
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To add a group

1. On the Add Group page, click Add.

2. In the Add Group dialog box, in Name, 
type a new name, and then click Yes.

3. Click Next to continue to the next page.

To edit a group name

1. On the Add Group page, click Modify.

2. In the Modify Group dialog box, in Name, 
type a new name, and then click Yes.

3. Click Next to continue to the next page.

To delete a group

1. On the Add Group page, click Delete.

2. Click Yes to confirm that you want to delete 
the group.

3. Click Next to continue to the next page.
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Importing Cameras

On the Import page, you can import cameras into a group that you have created. You can 
import up to 64 cameras into each group.

To import cameras to a group

1. On the Import page, under Group, click the camera group that you want to import to.

2. Do one of the following:

• To import all the cameras to the group, click Import All. 

• To import selected cameras to the group, select the camera(s) you want to import 
(hold down the Ctrl key to select multiple cameras at the same time), and then click 
Import.

3. Click Next to continue to the next page, and then click Finished to close the setup wizard.
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Overview of User Interface Layout

This section provides a brief overview of the Multi-Site 4200 user interface and the Control 
Panel tab.

Menu Bar

Control 
Panel 
Icons



Getting Started | 17

800-12064V2 - B - 09/2014

Menu Bar

Menu Command Description

File

Open Captured Picture
Opens the Capture window. You can browse for and open 
captured image files stored on your PC’s hard drive. 

Open Video File
Opens the video player. Click the Open File button  on the 
video player to browse for and open recorded video files.

Open Log File
Opens the Log File window. You can browse for and open saved 
log files.

Exit Exits Multi-Site 4200.

System

Lock Locks the system. You must log in to unlock the system.

Switch User Opens Switch User window. New user must log in.

System Configuration Opens the System Configuration window.

Import Configuration File Imports a client configuration file from your PC.

Export Configuration File Exports a client configuration file to your PC.

View

1024*768 Resizes the display window to 1024 × 768 pixels. 

1280*1024 Resizes the display window to 1280 × 1024 pixels.

Full Screen Sets the display window to full screen.

Control Panel Opens the Control Panel tab.

Main View Opens the Main View tab.

E-map Opens the E-map tab. 

Event Search Opens the Event Search tab.

Remote Playback Opens the Remote Playback tab.

Tools

Import Camera Opens the Import Camera tab. 

Camera Settings Opens the Camera Setting tab. 

Account Management Opens the Account Management tab. 

Device Management Opens the Device Management tab. 

Broadcast

Device Arming Control Enables alarm notifications for a device.

AVI Format Conversion Converts video files to .avi format.

Help

Open Wizard Opens the setup wizard.

User Manual (F1)
Opens the user manual. You can also open the user manual by 
pressing F1 on your keyboard.

About Displays the software name and version. 
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Control Panel Layout

The Control Panel tab provides quick access to the most important and frequently used 
features.

Task Item Description

Operation

Main View
In the Main View tab you can view and record live video and play back locally 
stored video files.

E-map
In the E-map tab you can associate a device group with an e-map to visualize 
the location and distribution of cameras.

Event Search
In the Event Search tab you can search for video files recording motion 
detection and alarm events.

Remote Playback
In the Remote Playback tab you can search and play back video files stored 
on your DVR’s hard drive.

Import Camera
In the Import Camera tab you can import cameras (channels) into a device 
group.

Local Log Search
In the Local Log Search tab you can search alarm, operation, and system 
logs by date.

Management 
and 
Configuration

Account 
Management

In the Account Management tab you can create, edit, and delete user 
accounts.

Device 
Management

In the Device Management tab you can remotely configure the DVR’s 
network, alarm, user, hard drive, log, and other settings.

Camera Settings

In the Camera Settings tab you can remotely configure camera settings, 
including picture, video quality, recording schedule, privacy masks, event 
detection (motion, tampering, video loss), PTZ control, and network 
connection.

System 
Configuration

In the System Configuration tab you can configure Multi-Site 4200 system 
settings, including file saving paths, alarm sounds, and email notifications.



 

800-12064V2 - B - 09/2014

2
Basic Operations 2

This chapter contains the following sections: 

• Main View Screen Layout on page 20

• Viewing Live Video on page 22

• Recording Video on page 27

• Playing Back Recorded Video on page 29
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Main View Screen Layout

Video Window

Video Window Toolbar

Group

Cameras

Main View Toolbar

Active Tab (Red)

Alarm/Event Toolbar

Devices List



Basic Operations | 21

800-12064V2 - B - 09/2014

Camera Status Icons

Main View Toolbar

Video Window Toolbar

Button Name Description

Full Screen Display video in full screen mode. Press Esc to exit.

Layout Select different screen layout options.

Stop Stop live view for all cameras in group.

Play Start live view for all cameras in group.

Capture Save a still image for the selected camera. 

Start/Stop Recording Start or stop recording video for the selected camera.

Prev Page View previous camera.

Next Page View next camera.

Start Auto-switch Start auto-switching the screen by cameras or by groups.

Volume Adjust live audio volume for the selected camera by moving the slider. 
On the slider, click  to enable audio or  to disable audio.

Icon Description

Camera is online but not in live view.

Camera is offline.

Icon Description

Camera is in live view.

Camera is recording.

Button Name Description

Capture Save a still image.

Start/Stop Recording Start/stop recording video.

Start/Stop Two-way 
Audio

Start/stop two-way audio.

Digital Zoom Enter digital zoom mode.

PTZ Control Enter PTZ control mode.

Camera Status Open the Camera Status window.

Camera Settings Open the Camera Settings window.

Start/Stop Live View Stop live view.

Playback Remote instant playback of current camera.

Audio On/Mute Enable/disable live audio.
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Viewing Live Video

Starting and Stopping Live View

To view all the cameras in a group:

Double-click a group in the devices list. Video from all the cameras in the group appears in the 
video windows.

To view selected cameras in a group:

1. Double-click a camera in the devices list. Video from the selected camera appears in the 
highlighted video window (by default, the upper left window).

2. To view another camera, click another video window to highlight it, and then double-click 
the camera you want to view in that window. Do this for each camera that you want to 
view.

Note Alternatively, you can drag a camera directly from the devices list to the video 
window where you want to display the video.

To stop viewing all cameras:

On the Main View toolbar, click the Stop button .

To stop viewing selected cameras:

In the devices list, double-click the camera you want to stop viewing. Alternatively, click the Stop 
button on the video window toolbar .

Setting the Screen Layout

You can customize your screen layout.

To set the screen layout:

1. On the Main View toolbar, click the Layout 

button  to display the layout options.

2. Click the desired screen layout option.

To display video full screen:

On the Main Video toolbar, click the Full Screen button  to display video in full-screen 
mode. Press Esc to exit full-screen mode.
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Using Auto-Switch

When auto-switch mode is enabled, the video feed changes at regular intervals, cycling through 
all the connected cameras.

To start auto-switch:

1. On the Main View toolbar, click the 
drop-down arrow ( ).

2. Click Single-screen Auto-switch or 
Multi-screen Auto-switch.

3. Set the Switching Interval by moving the 
slider left or right.

4. Click the Start Auto-switch button  to 
enable auto-switch. 

To stop auto-switch:

Click the Stop Auto-switch button  to disable auto-switch.

Using PTZ Control in Live View

If the connected camera supports PTZ control, you can control it remotely.

To start PTZ control:

1. Move the mouse pointer to the bottom edge of the video window to display the toolbar.

2. On the video window toolbar, click the PTZ Control button  to open the PTZ control 
panel.
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The following table lists the PTZ control buttons and their functions:

You can control PTZ movement by clicking the direction buttons on the PTZ control panel. 
Alternatively, you can click on the video window where you want to move the camera. 

Button Description

Zoom

Focus

Iris

3D positioning 

Direction buttons 

Click  to start/stop the auto-scan function.

Speed adjustment for pan/tilt functions

Preset configuration

Pattern configuration

Patrol configuration

Call or play a preset/pattern/patrol.

Add/edit a preset/pattern/patrol.

Delete a preset/pattern/patrol.

Click in the screen area to move in the 
corresponding direction:
 Upper Left
 Up
 Upper Right
 Left
Right
 Lower Left
 Down
 Lower Right



Basic Operations | 25

800-12064V2 - B - 09/2014

Configuring Presets

You can set up the camera to go to a predefined position (preset). 

To add a preset:

1. In the PTZ control panel, click Preset.

2. Using the pan, tilt, and zoom controls, move the 
camera to the position that you want to define as the 
preset.

3. In the PTZ control panel, in the preset list, click the 
number of the preset you want to set, and then click 
the Add/Edit Preset button .

4. In Name, type a name for the preset, and then click Yes. The preset name you entered 
appears in the preset list next to the number.

To delete a preset:

1. In the PTZ control panel, click Preset.

2. Click the preset you want to delete in the preset list, and then click the Delete Preset 
button .

3. At the prompt, click Yes to confirm the deletion. If the deletion is successful, the message 
"Deleting preset succeeded" appears in the lower right corner of the screen.
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Configuring Patterns

You can set up the camera to follow a predefined pattern of movement.

To add a pattern:

1. In the PTZ control panel, click Pattern.

2. Click the Start Recording Pattern button .

3. Using the PTZ controls, select the camera 
movements that you want to define as the pattern.

4. When you are finished, click the Stop Recording 
Pattern button .

To call a pattern:

1. In the PTZ control panel, click Pattern.

2. Click the Call Pattern button . The camera 
follows the pattern that you have programmed.

3. When you are finished, click the Stop Calling 
Pattern button .

Configuring Patrols

You can set up the camera to follow a predefined path between two or more presets.

To add a patrol:

1. On the PTZ control panel, click Patrol.

2. Select a path from the drop-down list. You can 
define up to 16 paths.

3. Click the Add button  to add a preset.

4. In the Add Patrol No. dialog box, select the preset 
you want to add, enter the switching interval (1–255 
seconds), enter the desired patrol speed (1–40), and 
then click Yes.

5. Add additional presets following the procedure in steps 3 and 4. 

Click the Edit Patrol No button  to edit a preset in the patrol path.
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To call a patrol:

1. In the PTZ control panel, click Patrol.

2. Click the Call Patrol button . The camera follows the patrol path that you have defined.

3. When you are finished, click the Stop Calling Patrol button .

Recording Video

You can save video clips and screen captures to your local PC.

To save video to your PC:

1. In Main View, on the Main View toolbar, click the Start Recording button .

2. To stop recording, click the Stop Recording button . The saving path of the file 
appears in the lower right corner of the screen.

Note You can change the saving path in Control Panel > System Configuration > 
File. See Configuring File Saving Paths on page 90 for more information.

To save a captured image to your PC:

1. In Main View, on the Main View toolbar, click the Capture button . A thumbnail of 
the captured image, along with the saving path of the file, appears in the lower right corner 
of the screen.

Note You can change the saving path in Control Panel > System Configuration > 
File. See Configuring File Saving Paths on page 90 for more information.
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To view a captured image that you have saved:

1. In the Main View tab, in the left pane, click Picture.

2. In Camera, select a specific camera to search or leave it set to All Cameras. 

3. In Start Time and End Time, specify your search parameters. You can type the date and 
time manually, or you can click the calendar icon to display a graphical interface.

4. Click Search. The captured images matching your search parameters are displayed.

5. Double-click the captured image that you want to view. Alternatively, on the File menu, 
click Open Captured Picture, click  to open the folder where the images are stored, 
click the date you want to find, and then click the image you want to view.

To rename the image, click the Save As button .

To delete the image, click the Delete button .

To email the image, click the Email button .

Note To send the image to an email address, you must first configure the email 
settings. See Configuring Email Settings on page 92 for more information.
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Playing Back Recorded Video

Instant Playback

You can quickly play back video from the last few minutes or hours in the video window.

Note You can set the instant playback pre-time in Control Panel > System 
Configuration > General. See Configuring General System Settings on page 89 
for more information.

To play back video from the last few minutes:

1. In Main View, on the video window toolbar, click the Playback button . Playback of 
the last few minutes of video starts automatically in the video window.

2. Use the controls on the video window toolbar to control playback.

• Click  to speed up playback. Keep clicking to increase playback speed.

• Click  to slow down playback. Keep clicking to decrease playback speed.

• Click  to advance a frame.

• Click  to pause playback.

• Click  to stop playback.

3. To return to live view mode, click the Live View button  on the video window toolbar.
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To play back video from earlier in the day:

1. In Main View, on the video window toolbar, click the Playback button . Playback of 
the last few minutes of video starts automatically in the video window.

2. Drag the timeline at the bottom of the screen to the desired playback start time. You can 
click  or  to expand or narrow the timeline. The earliest start time is 00:00:00 of the 
current day. 

3. Use the controls on the video window toolbar to control playback.

• Click  to speed up playback. Keep clicking to increase playback speed.

• Click  to slow down playback. Keep clicking to decrease playback speed.

• Click  to advance a frame.

• Click  to pause playback.

• Click  to stop playback.

4. To return to live view mode, click the Live View button  on the video window toolbar.

Timeline
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Playing Back Locally Archived Video

You can search and play back recorded video files stored on your PC.

Video Player and Toolbar

To search and play back video files stored on your PC:

1. In Main View, in the left pane, click All File(s).

2. In the Camera list, select a specific camera to search or leave it set to All Cameras. 

3. In Start Time and End Time, specify your search parameters. You can type the date and 
time manually, or you can click the calendar icon to display a graphical interface.

Button Description

Pause playback.

 Start/stop playback.

Slow down playback (keep clicking to decrease playback speed).

Speed up playback (keep clicking to increase playback speed).

Advance to next frame.

Zoom in.

Enable audio (audio muted by default).

Capture still image.
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4. Click Search. The video files matching your search parameters are displayed. 

5. Double-click the file you want to play back.

6. Use the controls on the video player toolbar to control playback.

• Click  to speed up playback. Keep clicking to increase playback speed.

• Click  to slow down playback. Keep clicking to decrease playback speed.

• Click  to pause playback. 

• Click  to advance a frame.

To rename the video clip, click the Save As button .

To delete the video clip, click the Delete button .

To email the video clip, click the Email button . The video clip must be less than 5 MB to 
use this feature.

Note To send the video clip to an email address, you must first configure the email 
settings. See Configuring Email Settings on page 92 for more information.
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Playing Back and Downloading Remotely Archived Video

You can remotely search and play back recorded video files stored on your DVR.

Remote Playback Video Window and Toolbar

Button Description

Pause playback.

 Start/stop playback.

Slow down playback (keep clicking to decrease playback speed).

Speed up playback (keep clicking to increase playback speed).

Advance to next frame.

Zoom in.

Smart search.

Capture still image.

Start/stop recording video clip.

Download video clip.

Enable/disable audio (audio muted by default).
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To remotely search and play back video files stored on your DVR:

1. In Control Panel, click Remote Playback.

2. In the left pane, select the camera(s) that you want to search.

3. In File Type, select a specific file type to search or leave it set to All to search all file types.

4. Click the date you want to search on the calendar, and then click Search.

5. On the timeline, click the time at which you want to start playing video.

6. Use the controls on the video window toolbar to control playback.

Note You can only play audio on one channel at a time.

Indicates that recorded video is 
available for that day

Indicates that recorded video is 
not available for that day.
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To download video files from your DVR to your local PC:

1. In Control Panel, click Remote Playback.

2. In the left pane, select the camera(s) that you want to search.

3. Under File Type, select a specific file type to search or leave it set to All to search all file 
types.

4. Click the date you want to search on the calendar, and then click Search.

5. On the video window toolbar, click the Download button .

6. In the File Download dialog box, select the file(s) you want to download, and then click 
Download. You can download by file or by date. The "Download by Tag" option is not 
supported at this time.

Note By default, video files are saved in C:/Multi-Site4200/video/. You can change the 
saving path in Control Panel > System Configuration > File. See Configuring 
File Saving Paths on page 90 for more information.
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Playing Back Video by Event Type

You can search and play back recorded video files by event type.

To search and play back video files by event type:

1. In Control Panel, click Event Search.

2. Click Motion Detection or Alarm Input, depending on the event type you want to search 
for.

3. In Group, select the group you want to search.

4. Do one of the following:

• If you are searching for a motion detection event, in Camera, select the camera you 
want to search.

• If you are searching for an alarm input event, in IO, select the alarm input you want to 
search.

5. In Start Time and End Time, specify your search parameters. The start and end times 
must be within 24 hours of each other. You can type the date and time manually, or you 
can click the calendar icon to display a graphical interface.

6. Click Search. A list of search results is displayed.

7. Click in a window to make it active, and then, from the list of search results, double-click 
the video file you want to play. The file begins playing in the selected window.
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Playback Controls

During playback, right-click anywhere in the window to display the context menu. The context 
menu displays options for capturing, recording, downloading, enabling audio, selecting another 
camera, and for displaying the video in full-screen mode.

To change the playback speed, click the slider in the lower right of the screen.
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3
Management 3

This chapter contains the following sections:

• Managing Devices on page 39

• Importing Cameras on page 42

• Managing Logs on page 44

• Managing Alarms on page 48

• Managing E-Maps on page 50

• Managing User Accounts on page 58

Managing Devices

You can add a device, edit device settings, and delete devices in the Device Management tab.

To add a device

1. In Control Panel, click Device Management. 
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2. Click Show Online Devices to see a list of DVRs on the same network (LAN) as the PC 
that is running Multi-Site 4200.

3. In the Show Online Devices dialog box, in the list of discovered devices, click the DVR 
that you want to add.

4. Optionally, you can:

• Modify the DVR’s network information (you will need to enter the administrator 
password of the device to modify these fields).

• Restore the default password of the device (you will need to enter a recovery code 
provided by authorized engineers).

5. Click Select Device, and then click Yes to confirm your choice.

6. If your DVR uses hrgDDNS (a free Dynamic DNS service), in the Add Device dialog box, 
select the Private Domain Mode check box. If your DVR does not use hrgDDNS, leave the 
box unchecked.

7. In Nickname , type a descriptive name for 
your DVR.

8. If Private Domain Mode is enabled, in DNS 
Address, type www.hrgdvr-ddns.com.

If Private Domain Mode is not enabled, the 
Address box should show your DVR’s IP 
address or its DynDNS address. If the box is 
blank, type the DVR’s IP address of its 
DynDNS address.

9. If Private Domain Mode is enabled, in 
Device ID, type the serial number of your DVR 
(you can find this in Menu > Maintenance > 
Information on the DVR).
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If Private Domain Mode is not enabled, the Port box should show your DVR’s device port 
number. If the box is blank, type the device port number of the DVR. The default port number is 
8000.

10. In User Name, type the user name of your DVR. (The default user name is admin.)

11. In Password, type the password of your DVR. (The default password is 12345.)

12. Click Add to add your DVR to the devices list.

To edit a device’s settings

1. In Control Panel, click Device 
Management.

2. In the Device Management tab, click the 
name of the device that you want to edit, 
and then click Modify. Alternatively, 
double-click the name of the device.

3. In the Connection Settings dialog box, edit 
the desired settings, and then click Modify.

To delete a device

1. In Control Panel, click Device 
Management.

2. In the Device Management tab, click the 
name of the device that you want to delete, and then click Delete. The device is removed 
from the devices list.
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Importing Cameras

After you have added a device, you must add a group for your device and import cameras 
(channels) into that group. You can add up to 256 groups and you can import up to 64 cameras 
into each group.

Note If the Export to Group check box was selected when you added your DVR to the 
devices list, a group was created for your DVR and the cameras connected to the 
DVR were added to it.

Managing Groups

To add a group

1. In Control Panel, click Import Camera.
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2. Under Group, click Add.

3. In the Add Group dialog box, in Name, type a new name, and then click Yes.

To edit a group name

1. In Control Panel, click Import Camera.

2. Under Group, click Modify.

3. In the Modify Group dialog box, in Name, type a new name, and then click Yes.

To delete a group

1. In Control Panel, click Import Camera.

2. Under Group, click the name of the group that you want to delete, and then click Delete.

3. Click Yes to confirm that you want to delete the group.

Importing Cameras

To import cameras to a group

1. In Control Panel, click Import Camera.

2. Under Group, click the group that you want to import to.

3. Do one of the following:

• To import all the cameras to the group, click Import All. 

• To import selected cameras to the group, select the camera(s) you want to import 
(hold down the Ctrl key to select multiple cameras at the same time), and then click 
Import.
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Managing Logs

Multi-Site 4200 keeps a record of alarm and user activity for each camera. There are three types 
of logs that are kept.

• The alarm log contains a record of triggered alarms (for example, motion detection, video 
signal loss). 

• The operation log contains a record of user inputs (for example, starting or stopping live 
view, remote playback, PTZ control).

• The system log contains a record of when a user logs in and logs out.

Searching Logs

To search a log

1. In Control Panel, click Local Log Search. 

2. In Log Type, select the log type you want to search: Alarm Log, Operation Log, or 
System Log.

3. To narrow your search, choose one or more of the following limiters:

• Minor Type

• User Name

• Group

• Camera

4. Specify the date and time you want to search.
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a. In Start Time, click the calendar icon  to open the calendar, specify the desired 
start date and time, and then click Yes.

b. In End Time, click the calendar icon  to open the calendar, specify the desired end 
date and time, and then click Yes.

5. Click Search. All logs matching your search criteria are displayed.
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Saving Logs

You can save logs that you locate in a search to your local PC.

To save a log

1. In the Local Log Search tab, click Backup. The Log Backup dialog box opens.

2. Click the browse button . The Select Log File For Backup dialog box opens.

3. Click Log to open the Log folder.

4. In File name, type a name for the log file, and then click Save. The Log Backup dialog 
box opens, displaying the save path of the log file.

5. Click Backup to save the log.
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Opening Saved Logs

You can open log files that have been saved to your local PC.

To open a saved log

1. On the File menu, click Open Log File. The Log File window opens.

2. Click the browse button  to browse for the log file on your computer.

3. When you have located the log file, click the file to select it, and then click Open.
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The log file opens in the Log File window.

Managing Alarms

Viewing Alarm and Event Information

Alarm and Event buttons are displayed in the lower left corner of the screen. 

To show the alarm information panel, click Alarm.

To show the event information panel, click Event.

To hide the alarm/event information panel, click the Hide button . To auto-hide the panel, 
click the Auto Hide button .

To keep the alarm/event information panel open, click the Lock button .

To maximize the alarm/event information panel and display it as a new tab (Alarm Event), click 
the Maximize button .

At the bottom of the window there are five alarm/event categories listed: Motion Detection, 
Video Exception, Alarm Input, Device Exceptional, and Other Alarm. Select the check box 
next to each alarm/event that you want to display. 

To remove an alarm/event from the list, right-click the alarm/event that you want to remove, and 
then click Clear.

Linking Alarm Logs

Each alarm log shows the related alarm information, including the time the alarm occurred, the 
source, and the type of alarm. 
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You can click  or  to preview the alarm or send it by email. 

• Live View ( ): View the live video of the selected alarm source camera. 

• Send Email ( ): Send the alarm information by email. 

Note You need to configure email settings in Control Panel   System Configuration 
  Email before using the Send Email function. See Configuring Email Settings 
on page 92 for more information.

Blocking Alarms from a Device

You can block alarm information from a device if necessary. This can be useful when you are 
managing a large number of devices from a single Multi-Site 4200 remote client.

To block an alarm from a device

1. On the Tools menu, click Device Arming Control.

2. In the Device Arming Control dialog box, in the Encoding Device tab, clear the check 
box next to the device to block the alarm information. 

3. Click Yes to save your settings.

Note This function only blocks the selected alarm information from being received by 
this Multi-Site 4200 client. The alarm information can still be received by other 
clients.
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Managing E-Maps

You can associate a group with an e-map to visualize the location and distribution of the 
cameras. This feature is especially useful when an alarm is triggered.

You must add an e-map to start using the e-map function. You can add one e-map for each 
camera group.

To add an e-map

1. In Control Panel, click E-map.



Management | 51

800-12064V2 - B - 09/2014

2. In the E-map tab, in the left pane, select a camera group, and then click Add Map.

3. In the E-map Info dialog box, click the browse button  and browse to the directory 
where the map is stored. The picture format of the map should be .png, .jpg or .bmp.

4. Click the map file, and then click Open.

5. In the E-map Info dialog box, in Map Name, type a name for the map.

6. Click Yes to save your settings. The e-map is displayed in the E-map tab and the name of 
the map appears in the group list.
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Managing Hot Spots

You can add a camera label to the map to show the location of a camera. The label is called a 
hot spot. After the hot spots are added, the cameras are linked to the map. 

In the map preview window, you can see the live view of the camera. If an alarm triggered, an 
alarm icon  appears next to the camera label. 

To add a hot spot

1. In Control Panel, click E-map.

2. On the toolbar at the bottom of the E-map tab, click the Add Hot Spot button .

3. In the Add Hot Spot dialog box, select the check box(es) next to the camera(s) you want 
to add as hot spots, or select the All check box to add all cameras.

4. Next to Hotspot Color, select a color from the drop-down list.

5. Click Yes to save your settings. After being added as a hot spot, the camera icon in the 
devices list changes to .

6. Drag the camera hot spot icon to the approximate location of that camera on the map.
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To edit a hot spot

1. Do one of the following:

• Double-click the hot spot icon on the map.

• Right-click the hot spot, and then click Modify.

• Select a hot spot on the map, and then click the Modify Hot Spot button  on the 
toolbar.

2. In the Modify Hot Spot dialog box, edit the name and/or color of the hot spot, and then 
click Yes.

To delete a hot spot

Do one of the following:

• Right-click the hot spot, and then click Delete.

• Select the hot spot icon on the map, and then click the Delete Hot Spot button  on the 
toolbar.

Previewing the Map

After you have finished setting up hot spots, click Map Preview on the toolbar to view the e-map. 
The map shows the location of the linked cameras as hot spots.
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When you double-click a hot spot, a video window opens displaying live video from the camera.

If an alarm is reported, an alarm icon  appears on the map to alert you.
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To view alarm details, double-click the alarm icon.

To clear the alarm, click the alarm icon  on the toolbar.

Managing Hot Regions

You can link a map to another map as a hot region. The added map is called a child map and 
the map being added to is called the parent map.

Note A map can be added as a hot region only once.

To add a hot region

1. In Control Panel, click E-map.

2. On the toolbar at the bottom of the E-map tab, click the Add Hot Region button .

3. In the Add Hot Region dialog box, select the map(s) you want to add as a hot region, or 
select the All check box to add all maps.

4. Next to Hot Region Color, select a color from the drop-down list, and then click Yes.



www.honeywell.com/security

56 | Multi-Site 4200 for Windows

5. Drag the map icon to the desired location for the hot region on the e-map.

To edit a hot region

1. Do one of the following:

• Double-click the hot region icon on the map.

• Right-click the hot region, and then click Modify.

• Select a hot spot on the map, and then click the Modify Hot Region button  on 
the toolbar.

2. In the Modify Hot Region dialog box, edit the name and/or color of the hot spot, and then 
click Yes.

To delete a hot region

Do one of the following:

• Right-click the hot region, and then click Delete.

• Select the hot region icon on the map, and then click the Delete Hot Region button  
on the toolbar.
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Previewing the Map

After you have finished setting up hot regions, click Map Preview on the toolbar to view the 
e-map. The map shows the location of the linked maps as hot regions.

When you double-click a hot region, the child map opens in the E-map tab. Click  to go 
back to the parent map.
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Managing User Accounts

You can create multiple user accounts in Multi-Site 4200 and you can specify user privileges for 
each account you create. 

To remotely configure user accounts and permissions for connected devices, see Configuring 
Device User Settings on page 67.

To create a new user account

1. In Control Panel, click Account Management.

2. Click Add.
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3. In the Add User dialog box, in User Type, select Administrator or Operator from the 
drop-down list. 

4. In User Name and Password, type the account user name and password. Re-type the 
password in the Confirm box.

5. Select the user privileges for the account from the list. The Administrator user has all user 
privileges by default.

Note Not all of the user privileges available to Administrator users are available to 
Operator users. For example, only Administrator users can exit Multi-Site 4200.

6. Click Save to save your settings. The new account appears in the accounts list in the 
Account Management tab. All of the user privileges associated with the account take 
effect immediately.

To edit a user account

1. In Control Panel, click Account Management, click the account you want to edit, and 
then click Modify.

2. In the Modify User dialog box, select or clear the check boxes to add or remove user 
privileges, and then click Save. All of the user privileges associated with the account take 
effect immediately.

To delete a user account

In Control Panel, click Account Management, click the account you want to delete, and then 
click Delete.
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4
Configuration 4

This chapter contains the following sections: 

• Remotely Configuring Devices on page 61

• Remotely Configuring Cameras on page 76

• Configuring System Settings on page 89

Remotely Configuring Devices

You can remotely configure your DVR in the Device Management tab.

To open the Device Management tab

1. In Control Panel, click Device Management.

2. Select the device you want to configure, and click Remote Configuration to enter the 
Device Parameters window. 
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Viewing Basic Device Information

On the Information page you can check basic device information for your DVR, including the 
device type, number of channels, number of hard disk drives, number of alarm inputs and 
outputs, device serial number, and version information. 
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Configuring General Device Settings

On the General page you can set the basic parameters of the device.

The following table describes the fields on the General page.

Note Always click Save before exiting the Device Parameters window.

Field Description

Device Name Enter a name for the device.

Device No. Enter a device number for remote control, if applicable.

Record Replace Select Yes to overwrite the DVR hard drive when the hard drive 
is full.
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Configuring General Network Settings

On the Network page you can configure network parameters of the device.

The following table describes the fields in the General tab on the Network page.

Note Always click Save before exiting the Device Parameters window.

Field Description

NIC Type Select the NIC type of the device.

Device IP Address Displays the IP address of the device.

Subnet Mask Displays the subnet mask IP for the device.

Gateway Displays the default gateway IP for the device.

MAC Address Displays the MAC address of the device. This is a read-only field.

MTU(Byte) Enter the maximum transport unit. The default value is 1500.

Device Port Enter the network port of the device. The default port number is 8000.

Multicast Address Not supported at this time.

HTTP Port Enter the web service port. The default port number is 8001.

RTSP Port Enter the RTSP port. The default port number is 8002.

Bandwidth Throttle Select a bandwidth throttle value (from 1 to 30 Mbps).
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Configuring Advanced Network Settings

Click the Advanced tab on the Network page to configure advanced network parameters for 
the device.

The following table describes the fields in the Advanced tab on the Network page.

Note Always click Save before exiting the Device Parameters window. 

Field Description

NTP Click Set to enable and configure Network Time Protocol (NTP) time 
synchronization.

Email Click Set to configure email account settings for the device.

PPPOE Click Set to enable and configure Point-to-Point Protocol over Ethernet (PPPOE).

DDNS Click Set to enable and configure Dynamic DNS (DDNS).

Note After completing the DDNS setup, click Register after clicking Save.

Advanced 
Settings

Click Set to configure DNS server addresses and alarm host IPs and ports.

SNMP Click Set to configure Simple Network Management Protocol (SNMP).
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Configuring Device Alarm Settings

On the Alarm page you can configure alarm input/output and linkage actions for the device.

The following table describes the fields on the Alarm page.

Field Description

Alarm Input Settings

Alarm Input Select an alarm input channel for configuration.

Alarm Source IP address of the digital alarm input. Local is the hard-wired alarm 
input configuration on the device. This is a read-only field.

Alarm Name Enter a name for the alarm input channel.

Alarm Status Set the alarm to Normal Open or Normal Closed.

Handling Select this check box to activate alarm-triggered actions.

Arming Schedule Set the time schedule to handle the alarm-triggered actions. The 
schedule template can be configured in Camera Settings > 
Schedule. See Configuring the Recording Schedule on page 79 for 
more detailed information. 

Linkage Check the alarm actions which are required to be activated when 
the alarm input triggered, and select corresponding channel 
number if required. 

Alarm Output Settings

Alarm Output Select an alarm output channel for configuration.
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Note Always click Save before exiting the Device Parameters window.

Configuring Device User Settings

On the User page you can create or delete user accounts and configure permissions for each 
connected device.

Alarm Source IP address of the digital alarm output. Local is the hard-wired alarm 
input configuration on the device. This is a read-only field.

Output Delay Select the delay duration for the alarm output.

Arming Schedule Set the time schedule to handle the alarm-triggered actions. The 
schedule template can be configured in Camera Settings > 
Schedule. See Configuring the Recording Schedule on page 79 for 
more detailed information. 

Field Description
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To create a new user account

1. Click Add. The User dialog box opens.

2. In the User Information area, in User Type, select Guest or Operator.

3. In User Name and Password, type a user name and password. Re-type the password in 
the Confirm box.

4. Optionally, do one or both of the following:

• In IP Address, type the IP address of the user’s computer.

• In MAC Address, type the MAC address of the user’s computer.

5. In the User Privilege area, select the user privilege(s) you want to assign to the new 
account. 

6. Click Yes. The new user account appears in the user list.

Note Always click Save before exiting the Device Parameters window.
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Configuring Device Hard Disk Drive Settings

On the HDD page you can configure network disk and HDD group settings. You can also modify 
HDD information or format the HDD(s).
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Configuring Device Exceptions

On the Exception page you can configure alarm actions and set the alarm output(s).

Note Always click Save before exiting the Device Parameters window.
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Searching and Viewing Recorded Video Stored on Device

On the File page you can search for and view recorded video files stored on the device.

Note Always click Save before exiting the Device Parameters window.
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Searching and Displaying Log Files Stored on Device

On the Log page you can search for and view log files stored on the device. 

To search for log files

1. In Search Mode, select All, By Type, By Time, or By Type & Time.

2. If searching by type, do the following:

a. In Major Type, select Alarm, Exception, Operation, or Information.

b. In Minor Type box, select a subcategory, and then click Search.

3. If searching by time, in Start Time and End Time, specify the date and time you want to 
search, and then click Search.

To back up log files remotely

If the device supports remote backup, select the files you want to back up, and then click 
Backup.

Note Always click Save before exiting the Device Parameters window.
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Configuring Holiday Settings

On the Holiday page you can configure holiday recording settings for the device.

To configure holiday recording settings

1. Select the holiday you want to configure from the list, and then click the Edit button .

2. In the Edit Holiday dialog box, configure the following settings:

3. Click Yes to confirm your settings.

Note Always click Save before exiting the Device Parameters window.

• Enable Holiday Select/clear the check box to enable/disable this setting.

• Holiday Name Enter the name of the holiday.

• Mode Select By Date, By Week, or By Month.

• Start Time Select the start date for the setting. Format varies by mode.

• End Time Select the end date for the setting. Format varies by mode.
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Configuring Remote Upgrades

On the Others page you can remotely upgrade the device firmware. 

To remotely upgrade the device firmware

1. In the Remote Upgrade area, next to Upgrade File, click  to browse to the location of 
the firmware upgrade file on your local PC.

2. Select the firmware upgrade file, and then click Open.

3. Click Upgrade to start the firmware upgrade on your device. You must reboot your device 
to complete the upgrade.

Note Always click Save before exiting the Device Parameters window.
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Viewing Network Resource Usage

On the Resource User page you can view network usage data for Live View, Playback, and the 
IPC Module.

Note Always click Save before exiting the Device Parameters window.
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Remotely Configuring Cameras

You can remotely configure camera parameters in the Camera Settings tab.

To configure a camera

1. In Control Panel, click Camera Settings.

2. In Camera, select the camera you want to configure from the drop-down list. 
Live video from the selected camera appears in the video window.
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Configuring Picture Settings

Click Picture Settings to configure the camera picture. In the Mode drop-down list, select the 
desired mode: Standard, Indoor, Dim, Outdoor, or Customize. If Customize is selected, the 
following settings appear:

Move the sliders to adjust the brightness, contrast, saturation, and/or hue of the video image.

Configuring Video Quality

Click Video Quality to configure the video stream quality and resolution of the camera.
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To configure the video stream quality and resolution

1. Next to Video Quality, click Low, Middle, or High to set the main stream video quality.

2. Next to Main Stream, select the resolution you want from the drop-down list.

3. To configure additional settings for the main stream, click Advanced Settings.

a. In Stream Type, select Video or 
Video & Audio.

b. In Bitrate Type, select Variable 
or Constant Bitrate.

c. In Baud Rate, select the baud 
rate you want to use. Choose a 
value between 32 Kbps and 
3072 Kbps or click Customize to 
enter your own value.

d. In Frame Rate, select the frame 
rate you want to use. Choose a 
value between 1/16 and Full 
Frame.

e. In Frame Type, select P or BBP.

f. In I Frame Interval, enter the I-frame interval you want to use. The default value is 25.

g. Click Yes to confirm your settings.

4. Configure the sub stream and event video settings following the same steps as above.

5. Click Save to save your settings.

6. If you want to copy these settings to additional cameras, do the following:

a. Click Copy to .

b. In the Copy to dialog box, select the camera(s) you want to copy the settings to (or 
select All to copy the settings to all cameras), and then click Yes.
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Configuring the Recording Schedule

Click Schedule to set the recording schedule of the camera.

To set the recording schedule

1. Select the Local Recording check box.

2. Next to Record Schedule, click the calendar icon to open the Templates dialog box.

3. Select a pre-designed template (All-day Template, Weekday Template, Alarm 
Template) or customize your own, and then click Confirm.
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To create a customized recording schedule template

1. In the Templates dialog box, do one of the following:

• Select a numbered template (for example, Template 01), click Edit, and then type a 
name for the template.

• Select Customized.

2. Select one of the following recording types:

• Schedule Recording: Normal scheduled recording (displays as blue).

• Event Recording: Scheduled recording triggered by events (displays as yellow).

• Command: Scheduled recording triggered by commands (displays as green).

3. Drag the mouse pointer in the timeline for each day of the week to define the recording 
start and end times for that day. Clicking on the colored bar displays the exact start and 
stop times.

4. To copy the recording time to another day of the week, click the colored bar to select it, 
and then click the Copy To button . Select the check box(es) of the day(s) you want to 
copy to (or select the All check box to copy to all days), and then click Confirm.

5. Click Confirm.

To delete recording times

• To delete a specific recording time from a customized recording schedule template, in the 
Templates dialog box, click the recording time you want to delete, click the Delete button 

, and then click Confirm.

• To delete all the recording times from a customized recording schedule template, in the 
Templates dialog box, click the Delete All button , and then click Confirm.

To configure advanced settings

1. Click the Advanced Settings button.

2. In the Advanced Settings dialog box, set the pre-record and post-record times, video 
expired time, enable or disable redundant record, enable or disable audio, and then click 
Yes.

To save the recording schedule settings

Click Save to save your settings.

To copy the recording schedule settings to additional cameras

1. Click Copy to .

2. In the Copy to dialog box, select the camera(s) you want to copy the settings to (or select 
All to copy the settings to all cameras), and then click Yes.



Configuration | 81

800-12064V2 - B - 09/2014

Configuring the Video Display

Click Video Display to set up the video display and create privacy masks and text overlays for 
the camera.

To set up the video display

1. Do one or more of the following:

• To display the camera name in the video window, select the Display Name check 
box. Enter the camera name you want to appear on-screen in the Camera Name box. 
Drag the camera name box to the desired location in the video window.To stop 
displaying the camera name in the video window, clear the Display Name check box.

• To display the current date/time in the video window, select the Display Date check 
box. Specify the date and time format in the Date Format and Time Format boxes. 
Drag the date/time box to the desired location in the video window. To stop displaying 
the current date/time in the video window, clear the Display Date check box.

• To display the current day of the week in the video window, select the Display Week 
check box. To stop displaying the current day of the week in the video window, clear 
the Display Week check box.
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2. In OSD Attribute, select one of the following options:

• Transparent And Flash

• Transparent And Not Flash

• Flash And Not Transparent

• Not Transparent and Not Flash

3. Click Save to save your settings.

4. If you want to copy these settings to additional cameras, do the following:

a. Click Copy to .

b. In the Copy to dialog box, select the camera(s) you want to copy the settings to (or 
select All to copy the settings to all cameras), and then click Yes.

To create a privacy mask

1. Select the Enable Privacy Mask check box. 

2. Directly below the video window, select Draw Privacy Mask Area from the drop-down list. 

3. In the video window, drag the mouse pointer over the area you want to mask. The privacy 
mask appears as an outlined gray shape overlaid onto the screen.

4. Create additional privacy masks if desired. You can create up to four masks.

5. Click Save to save your settings.

To edit a privacy mask 

• Drag the handles on the edges of the mask to adjust its size and shape.

• Drag the center of the mask to move it to a different location, and then click Save.

To delete a privacy mask

1. Ensure that the Enable Privacy Mask check box is selected.

2. Directly below the video window, select Draw Privacy Mask Area from the drop-down list. 
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3. Do one of the following:

• To delete a single privacy mask, select the privacy mask, and then click the Delete 
button ,

• To delete multiple privacy masks at once, click the Delete All button .

4. Click Save to save your settings.

To create an OSD text overlay

1. In the Text Overlay area, select a check box, type the text you want to appear in the video 
window, and then click Save. The text appears in the upper left corner of the video 
window.

2. Drag the text to the desired location in the video window, and then click Save.

To delete an OSD text overlay

In the Text Overlay area, clear the check box next to the text you want to delete, and then click 
Save.

Configuring Motion Detection

Click Motion Detection to set up motion detection for the camera.
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To create a motion detection area

1. Select the Enable Motion Detection check box.

2. In the video window, drag the mouse pointer over the portion of the window you want to 
designate as a motion detection area, or click the All Regions button  to designate the 
entire video window as the motion detection area.

3. Move the Sensitivity slider, located directly below the video window, to adjust the motion 
detection sensitivity.

4. If applicable, drag the motion detection area to the desired location in the video window.

5. Click Save to save your settings.

To delete a motion detection area

1. Do one of the following:

• To delete a single motion detection area, click the Delete button .

• To delete all motion detection areas, click the Delete All button .

2. Click Save to save your settings.

To set up a motion detection arming schedule

1. Ensure that the Enable Motion Detection check box is selected.

2. Next to Arming Schedule, click the calendar icon to open the Templates dialog box (it is 
set to All-day Template by default).

3. Select a pre-designed template (All-day Template, Weekday Template, Alarm 
Template) or customize your own, and then click Confirm.

The steps for setting up the motion detection arming schedule are similar to those used to 
set up the recording schedule. Refer to Configuring the Recording Schedule on page 79 
for more information.

To set up motion detection actions

1. In the Linkage Method area, select one or more of the following check boxes.

2. If Trigger Alarm Output was selected in step 1, select the alarm output(s) you want to 
activate when motion is detected.

3. Under Triggered Camera, select the cameras you want to activate when motion is 
detected.

4. Click Save to save your settings. 

• Audible Warning Triggers an audible warning on the device when 
motion is detected.

• Notify Surveillance Center Sends alarm information to CMS software when 
motion is detected.

• Trigger Alarm Output Activates one or more alarm outputs when 
motion is detected.

• Email Linkage Sends an email when motion is detected.

• Full Screen Monitoring Video window changes to full screen mode when 
motion is detected.
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Configuring the Tampering Alarm

Click Tampering Alarm to set up a tampering alarm for the camera. A tampering alarm is 
triggered when the camera is blinded so that the area being monitored is no longer visible.

To create a tampering detection area

1. Select the Enable Tampering Alarm check box.

2. The tampering detection area covers the entire video window by default. If you only want 
to cover a portion of the video window, adjust the dimensions and placement of the grid. 
Clicking the All Regions button  will restore the tampering detection area to the entire 
video window.

3. Move the Sensitivity slider, located directly below the video window, to adjust the 
tampering detection sensitivity.

4. Click Save to save your settings.

To delete a tampering detection area

Click the Delete button , and then click Save.

To set up a tampering detection arming schedule

1. Ensure that the Enable Tampering Alarm check box is selected.

2. Next to Arming Schedule, click the calendar icon to open the Templates dialog box (it is 
set to All-day Template by default).
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3. Select a pre-designed template (All-day Template, Weekday Template, Alarm 
Template) or customize your own, and then click Confirm.

The steps for setting up the tampering detection arming schedule are similar to those used 
to set up the recording schedule. Refer to Configuring the Recording Schedule on page 79 
for more information.

To set up tampering alarm actions

1. In the Linkage Method area, select one or more of the following check boxes.

2. If Trigger Alarm Output was selected in step 1, select the alarm output(s) you want to 
activate when camera tampering is detected.

3. Click Save to save your settings. 

Configuring Video Loss Detection

Click Video Loss to set up video loss detection for the camera.

• Audible Warning Triggers an audible warning on the device when camera 
tampering is detected.

• Notify Surveillance Center Sends alarm information to CMS software when camera 
tampering is detected.

• Trigger Alarm Output Activates one or more alarm outputs when camera 
tampering is detected.

• Email Linkage Sends an email when camera tampering is detected.

• Full Screen Monitoring Video window changes to full screen mode when 
camera tampering is detected.
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To set up video loss detection

1. Select the Enable Video Loss Detection check box.

2. Next to Arming Schedule, click the calendar icon to open the Templates dialog box (it is 
set to All-day Template by default).

3. Select a pre-designed template (All-day Template, Weekday Template, Alarm 
Template) or customize your own, and then click Confirm.

The steps for setting up the video loss detection arming schedule are similar to those used 
to set up the recording schedule. Refer to Configuring the Recording Schedule on page 79 
for more information.

4. In the Linkage Method area, select one or more of the following check boxes.

5. If Trigger Alarm Output was selected in step 1, select the alarm output(s) you want to 
activate when the video connection is lost.

6. Click Save to save your settings.

Configuring PTZ Settings

If the camera is a PTZ camera, click PTZ Control to specify PTZ connection parameters, 
including baud rate, data bit, stop bits, parity, flow control, protocol type, and address.

• Audible Warning Triggers an audible warning on the device when the 
video connection is lost.

• Notify Surveillance Center Sends alarm information to CMS software when the 
video connection is lost.

• Trigger Alarm Output Activates one or more alarm outputs when the video 
connection is lost.

• Email Linkage Sends an email when the video connection is lost.

• Full Screen Monitoring Video window changes to full screen mode when the 
video connection is lost.
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Note The PTZ parameters should be consistent with the settings of the PTZ on the DVR 
to ensure valid PTZ control.

To configure PTZ settings

1. In Baud Rate, select a value between 50 and 115.2K. The default is 9600.

2. In Data Bit, select a value between 5 and 8. The default value is 8.

3. In Stop Bit, select 1 or 2. The default value is 1.

4. In Parity, select None, Odd, or Even. The default setting is None.

5. In Flow Control, select None, Software, or Hardware. The default setting is None.

6. In Protocol Type, select a protocol from the list. The default protocol is VCL.

7. In PTZ Address, enter the address of the PTZ camera. 

8. Click Test to display the PTZ controls. Use the PTZ controls to test PTZ function.

9. Click Save to save your settings. 

10. If you want to copy these settings to additional PTZ cameras, do the following:

a. Click Copy to .

b. In the Copy to dialog box, select the camera(s) you want to copy the settings to (or 
select All to copy the settings to all cameras), and then click Yes.

Configuring the Network Connection

Click Network Connection to specify the network protocol type and video stream settings for 
the camera.
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Configuring System Settings

You can configure Multi-Site 4200 system settings in the System Configuration window.

Configuring General System Settings

To configure general system settings

1. In Control Panel, click System Configuration.

2. Configure any of the following settings:

Setting Description

Log Keeping Time Sets the length of time logs are kept: One Week, Half a 
Month, One Month.

View Scale Sets the aspect ratio for displaying video in live view 
mode: Full Screen, 4:3, or 16:9.

Instant Playback Pre-Time Sets the amount of video to play back during instant 
playback: 3 min., 5 min., or 10 min.

Serial Port Sets the serial port: NULL, COM1, COM2, COM3, COM4.

Picture Quality Sets video picture quality priority: Low, Middle, or High.

Network Performance Sets network performance priority: Low, Middle, or 
High.
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3. Click Save to save your settings, or click Default to return to the factory default settings.

Configuring File Saving Paths

You can change the assigned file saving paths for storing video files, captured images, and 
configuration files.

To change a file saving path

1. In Control Panel, click System Configuration.

2. In the left navigation pane, click File.

3. Next to the path you want to change, click the browse button .

4. In the Select File Path dialog box, type the name of the directory where you want to save 
files in Directory or browse to the directory using the arrow buttons, and then click 
Choose.

5. Repeat steps 3 and 4 for each path that you want to change.

6. Click Save to save your settings, or click Default to return to the factory default settings.

CPU Performance Sets CPU performance priority: Low, Middle, or High.

Enable Screen Toolbar 
Display

When selected, displays toolbar at the bottom of the 
screen during live view or playback mode. 

Enable Auto-login When selected, user is logged in automatically.

Resume Live View Status When selected, enables the resume live view status 
option.

Auto Time Adjustment Sets the time to the selected value. 

Setting Description
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Configuring Alarm Sounds

You can change the assigned alarm sounds for motion detection, video exception, and device 
exception alarms, and for alarm inputs.

To change an alarm sound

1. In Control Panel, click System Configuration.

2. In the left navigation pane, click Alarm Sound.

You can sample the current alarm sounds by clicking the test button  next to each 
audio file (.wav).

3. Next to the alarm sound you want to change, click the browse button . 

4. In the Open Video File dialog box, browse to the location of the new audio file (.wav) 
using the arrow buttons, and then click Open.

5. Repeat steps 3 and 4 for each alarm sound that you want to change.

6. Click Save to save your settings, or click Default to return to the factory default settings.
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Configuring Email Settings

You can set email parameters, including the SMTP server, port number, user name and 
password, sender and recipient addresses, and SSL.

To configure email settings

1. In Control Panel, click System Configuration.

2. In the left navigation pane, click Email.

3. Enter values for the SMTP Server, Port, User Name, Password, Sender's Address, and 
Receiver's Address.

4. If you want to enable SSL security protocol, click Enable SSL.

5. Click Send Test Email to confirm that the email settings are correct. 

6. Click Save to save your settings, or click Default to return to the factory default settings.



 

800-12064V2 - B - 09/2014

A
Troubleshooting A

The following table provides troubleshooting information for Multi-Site 4200:

If this happens... This might be the problem... So try this...

The Live View for a 
device fails.

• Unstable or insufficient network 
performance. 

• The device might be offline.
• Too many accesses to the remote device 

might result in too high of a load for the 
device. 

• The current user might not have 
permission for Live View.

• The version of the client software might 
need to be upgraded. 

• Check the network status and disable 
not-in-use processes on your PC. 

• Check the device’s network status. 
• Restart the device or disable other 

remote access to the device. 
• Log in as the admin user and try 

again.
• Download the newest version of the 

client software. 

Normal recording and 
the remote recording are 
confused.

• We say local recording when we use the 
client software, it refers to the recording 
on the PC running the client.

• Remote recording refers to the 
recording action commanded by the 
client on the device side, which stores the 
record files in the HDD of the device.

Downloading the 
playback file either fails 
or is too slow. 

• Unstable or insufficient network 
performance. 

• The NIC type is not compatible.
• Too many accesses to the remote device 

might result in too high of a load for the 
device.

• The current user might not have 
permission for playback.

• The version of the client software might 
need to be upgraded. 

• Check the network status and disable 
not-in-use processes on your PC.

• Directly connect the PC running the 
client to the device to check the 
compatibility of the NIC card.

• Restart the device or disable other 
remote access to the device. 

• Log in as the admin user and try 
again.

• Download the newest version of the 
client software.
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